PCI-1680U
2-Port CAN Interface Universal PCI Communication Card w/ Isolation

PCI-1682U
2-port CAN Interface Universal PCI Communication Card w/ CANopen
Copyright

The documentation and the software included with this product are copyrighted 2010 by Advantech Co., Ltd. All rights are reserved. Advantech Co., Ltd. reserves the right to make improvements in the products described in this manual at any time without notice. No part of this manual may be reproduced, copied, translated or transmitted in any form or by any means without the prior written permission of Advantech Co., Ltd. Information provided in this manual is intended to be accurate and reliable. However, Advantech Co., Ltd. assumes no responsibility for its use, nor for any infringements of the rights of third parties, which may result from its use.

Acknowledgements

Intel and Pentium are trademarks of Intel Corporation.
Microsoft Windows and MS-DOS are registered trademarks of Microsoft Corp.
All other product names or trademarks are properties of their respective owners.

Product Warranty (2 years)

Advantech warrants to you, the original purchaser, that each of its products will be free from defects in materials and workmanship for two years from the date of purchase.

This warranty does not apply to any products which have been repaired or altered by persons other than repair personnel authorized by Advantech, or which have been subject to misuse, abuse, accident or improper installation. Advantech assumes no liability under the terms of this warranty as a consequence of such events.

Because of Advantech’s high quality-control standards and rigorous testing, most of our customers never need to use our repair service. If an Advantech product is defective, it will be repaired or replaced at no charge during the warranty period. For out-of-warranty repairs, you will be billed according to the cost of replacement materials, service time and freight. Please consult your dealer for more details.

If you think you have a defective product, follow these steps:

1. Collect all the information about the problem encountered. (For example, CPU speed, Advantech products used, other hardware and software used, etc.) Note anything abnormal and list any onscreen messages you get when the problem occurs.
2. Call your dealer and describe the problem. Please have your manual, product, and any helpful information readily available.
3. If your product is diagnosed as defective, obtain an RMA (return merchandize authorization) number from your dealer. This allows us to process your return more quickly.
4. Carefully pack the defective product, a fully-completed Repair and Replacement Order Card and a photocopy proof of purchase date (such as your sales receipt) in a shippable container. A product returned without proof of the purchase date is not eligible for warranty service.
5. Write the RMA number visibly on the outside of the package and ship it prepaid to your dealer.
Declaration of Conformity

CE

This product has passed the CE test for environmental specifications when shielded cables are used for external wiring. We recommend the use of shielded cables. This kind of cable is available from Advantech. Please contact your local supplier for ordering information.

FCC Class A

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in

Technical Support and Assistance

1. Visit the Advantech web site at http://support.advantech.com.cn where you can find the latest information about the product.
2. Contact your distributor, sales representative, or Advantech’s customer service center for technical support if you need additional assistance. Please have the following information ready before you call:
   – Product name and serial number
   – Description of your peripheral attachments
   – Description of your software (operating system, version, application software, etc.)
   – A complete description of the problem
   – The exact wording of any error messages

Packing List

Before setting up the system, check that the items listed below are included and in good condition. If any item does not accord with the table, please contact your dealer immediately.

- PCI communication interface card
- Industrial Communication Driver, Utility and PCI communication card user's manual in ICOM CD-ROM
Safety Precaution - Static Electricity

Follow these simple precautions to protect yourself from harm and the products from damage.

- To avoid electrical shock, always disconnect the power from your PC chassis before you work on it. Don't touch any components on the CPU card or other cards while the PC is on.
- Disconnect power before making any configuration changes. The sudden rush of power as you connect a jumper or install a card may damage sensitive electronic components.
Contents

Chapter 1 Introduction.............................................1
1.1 Description .................................................................2
1.2 Features .............................................................................2
1.3 Specifications .......................................................................3
1.4 Ordering Information .........................................................3

Chapter 2 Install WDM driver ........................................5
2.1 Begin to use Advantech CAN device driver ....................6
2.1.1 PCI device setup ..............................................................7
2.1.2 ISA device setup ..............................................................8
2.1.3 Port setup .................................................................14
2.1.4 Device setup ...............................................................15

Chapter 3 Hardware Installation ..............................17
3.1 Initial Inspection ..............................................................18
3.2 Jumper Locations & Setting .............................................19
  Figure 3.1 PCI-1680U Silk Screen ..................................19
  Figure 3.2 PCI-1682U Silk Screen .................................20
3.2.1 How to Set Jumpers .....................................................21
  Figure 3.3 How to Set Jumpers .......................................21
3.2.2 Terminator Resistor Setup .........................................21
  Table 3.1: PCI-1680U/1682U Terminator Resistor Reference ..21
3.3 Card Installation ............................................................21

Chapter 4 Software Requirements .....................23
4.1 Introduction .................................................................24
4.1.1 Definitions, Acronyms, and Abbreviations ...................24
4.1.2 Reference .................................................................24
4.2 Overview of Advantech CAN Windows WDM&CE Driver .....24
  Table 4.1: Hardware Support ...........................................26
4.3 Introduction to API .........................................................27
4.3.1 CreateFile .................................................................27
4.3.2 CloseHandle ..............................................................29
4.3.3 DeviceIoControl .........................................................29
4.3.4 ReadFile.................................................................36
4.3.5 WriteFile.................................................................39
4.3.6 SetCommMask ..........................................................41
4.3.7 GetCommMask .........................................................42
4.3.8 WaitCommEvent .......................................................42
4.3.9 ClearCommError .......................................................44
4.3.10 GetOverlappedResult ............................................46
4.4 Structure List ...............................................................48
4.4.1 canmsg_t .................................................................49
4.4.2 CanStatusPar_t ..........................................................50
4.4.3 Command_par ..........................................................51
4.5 How to dispose message ..............................................54
4.5.1 How to send Standard frame, compatible with CAN 2.0A ...54
4.5.2 How to send Extended frame, compatible with CAN 2.0B ....55
4.5.3 How to send RTR frame ............................................55
Chapter 5  Pin Assignments and Wiring .......... 95

5.1 Pin Assignments .............................................. 96
    Figure 5.1 PCI-1680U/1682U DB-9 pin assignment .......... 96

5.2 Wiring ............................................................. 96
    Table 5.1: PCI-1680U/1682U Pin Wiring and Description ....... 96
Chapter 1

Introduction

This chapter provides a general description of the PCI-1680U and PCI-1682U.
Sections include:
- Description
- Features
- Specifications
- Ordering Information
1.1 Description

PCI-1680U/1682U is special purpose communication card that offers connectivity to Controller Area Networks (CAN) on your PC. With its built-in CAN controllers, the PCI-1680U/1682U provides bus arbitration and error detection with an automatic transmission repetition function. This drastically reduces the chance of data loss and ensures system reliability. You can run both CAN controllers independently at the same time. The PCI-1680U/1682U operates at baud rates up to 1 Mbps and can be installed in a PC expansion slot.

Controller Area Network

The CAN (Controller Area Network) is a serial bus system especially suited for networking "intelligent" I/O devices as well as sensors and actuators within a machine or plant. Characterized by its multi-master protocol, real-time capability, error correction, high noise immunity, and the existence of many different silicon components, the CAN serial bus system, originally developed by Bosch for use in automobiles, is increasingly being used in industrial automation.

Universal PCI

PCI-1680U/1682U provides truly universal connectivity, enabling a single product to be used to implement systems with dramatically different resource requirements. This makes PCI-1680U/1682U the most robust, most flexible, and most economical choice for any application requiring isolation. PCI-1680U/1682U uses a universal PCI connector compatible with both new 3.3 V signaling support required for plug-in boards by the PCI 2.2 specification and the 5 V signaling still used by many systems.

Optical Isolation Protection

On-board optical isolators protect your PC and equipment against damage from ground loops, increasing system reliability in harsh environments.

1.2 Features

- PCI bus specification 2.2 compliant
- Operates two separate CAN networks at the same time
- High speed transmission up to 1 Mbps
- 16 MHz CAN controller frequency
- Optical isolation protection of 1000 VDC ensures system reliability
- I/O address automatically assigned by PCI PnP
- LED indicates Transmit/Receive status on each port
- Windows DLL library and examples included
- Supports Windows 2000/XP/Vista/7 (x86 and x64), Linux and QNX
- Supports CANopen (PCI-1682U only)
1.3 Specifications

- Bus Interface: PCI bus spec. 2.2 compliant
- Ports: 2
- Protocol: CAN 2.0 A/B
- Communication Controller: NXP SJA1000
- CAN Transceiver: 82C250
- Signal Support: CAN_H, CAN_L
- CAN Controller Frequency: 16 MHz
- Speed (bps): Up to 1 Mbps programmable transfer rate
- Isolation Protection: 1,000 VDC
- Connector: Dual DB9 male connectors
- Power Consumption: 5 V @ 400 mA (Typical)
- Dimensions: 185 x 100 mm
- Operating Temperature: 0 ~ 65° C
- Storage Temperature: -25 ~ 85° C
- Operating Humidity: 5 ~ 95% Relative Humidity, non-condensing
- Storage Humidity: 0 ~ 95% Relative Humidity, non-condensing

1.4 Ordering Information

PCI-1680U: 2-port CAN-bus Universal PCI Communication Card with Isolation Protection
PCI-1682U: 2-port CAN-bus Universal PCI Communication Card with CANopen Support
Chapter 2

Install WDM driver

This chapter shows how to install WDM driver.
Sections include:
- PCI device setup
- ISA device setup
- Port setup
- Device setup
2.1 Begin to use Advantech CAN device driver

The following chart shows procedures of developing applications with Advantech CAN Driver.

There are different installation procedures for PCI device driver and ISA device driver, please respectively refer to:
PCI device installation procedures
ISA device installation procedures

**Note!** Default installation path for Advantech CAN WDM Driver is C:\Program Files\Advantech\AdvCAN.
### 2.1.1 PCI device setup

The following installation procedures are for PCI devices.
Take PCI-1680 as example:

1. First make sure hardware can be installed normally, then turn on the computer and enter operating system.
   You will see the following screen.

2. Click "Next" as the following.
3. Click "Finish" as the following.

![Found New Hardware Wizard]

2.1.2 ISA device setup
The following installation procedures are for ISA devices.
Take PCM-3680 as an example.
1. Follow the instructions in the manual to install the device, then turn on the computer to enter operating system.
2. Enter Control Panel, then select "Add Hardware".

![Add Hardware Wizard]
3. Click "Next" as the following.

4. Click "Next" as the following.
5. Click "Next" as the following.

6. Click "Next" as the following.
7. Click "Have Disk...".

![Add Hardware Wizard](image1.png)

8. Suppose inf file is installed under C:\Program Files\Advantech\AdvCAN\inf, click "Next" as the following.

![Locate File](image2.png)
9. Click "Next" as the following.

![Add Hardware Wizard](image)

10. When the installation is complete, click "View or change resources for this hardware (Advanced)" to configure resources of the device. Users can also directly click "Finish" and configure it in Device Manager.

![Completing the Add Hardware Wizard](image)
11. Select "Set Configuration Manually".

12. Configure according to your hardware.

13. Restart the computer to finish the installation.
2.1.3 Port setup

When bus driver is installed, users can install port driver AdvCanPort.sys according to the instructions. The installation file is AdvCanPort.inf. When the installation is finished, users can find the device in Device Manager and set ports in properties page.
2.1.4 Device setup

Users can set the device in "Windows Device Manager".

1. When driver is installed, users can open "Windows Device Manager" to set Advantech CAN device; "Windows Device Manager" can be opened in the following two ways:
   - Control Panel->Administrative Tools->Computer Management, then select "Device Manager";
   - Right click icon of "My Computer" and click "Manage", then select "Device Manager".

2. Click the eAutomation CAN port that you want to configure, and select "Properties" to open properties page of the port. Users can set the device in PORT_INFO.
Chapter 3

Hardware Installation

This chapter covers inspection and installation of hardware and drivers.
Sections include:
- Initial inspection
- Jumper locations & setting
- Card installation
3.1 Initial Inspection

You should find the following items inside the shipping package:
- PCI communication interface card
- Industrial Communication Driver, Utility and PCI communication card user's manual in ICOM CD-ROM

PCI-1680U/1682U was carefully inspected mechanically and electrically before it was shipped. It should be free of marks and scratches and in perfect working order when received.

As you unpack the PCI-1680U/1682U, check for signs of shipping damage (damaged box, scratches, dents, etc.). If it is damaged or it fails to meet specifications, notify our service department or your local sales representative immediately. Also notify the carrier. Retain the shipping carton and packing material for inspection by the carrier. After inspection we will make arrangements to repair or replace the unit.

When you handle the PCI-1680U/1682U, remove it from its protective packaging by grasping the rear metal panel. Keep the anti-vibration packing. Whenever you remove the card from the PC, store it in this package for protection.

**Warning!** Discharge your body's static electric charge by touching the back of the grounded chassis of the system unit (metal) before handling the board. You should avoid contact with materials that hold a static charge such as plastic, vinyl and Styrofoam. Handle the board only by its edges to avoid static damage to its integrated circuits. Avoid touching the exposed circuit connectors. We also recommend that you use a grounded wrist strap and place the card on a static dissipative mat whenever you work with it.
3.2 Jumper Locations & Setting

Figure 3.1 PCI-1680U Silk Screen
Figure 3.2 PCI-1682U Silk Screen
3.2.1 How to Set Jumpers

You configure your card to match the needs of your application by setting jumpers. A jumper is the simplest kind of electric switch. It consists of two metal pins and a small metal clip (often protected by a plastic cover) that slides over the pins to connect them. To "close" a jumper you connect the pins with the clip. To "open" a jumper you remove the clip.

![Open and Close Jumpers](image)

Figure 3.3 How to Set Jumpers

3.2.2 Terminator Resistor Setup

You can set the terminator resistor if necessary to match impedance. Each port has a separate resistor.

<table>
<thead>
<tr>
<th>Status</th>
<th>Value of Terminator Resistor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open mode</td>
<td>0</td>
</tr>
<tr>
<td>Close mode</td>
<td>120</td>
</tr>
</tbody>
</table>

Table 3.1: PCI-1680U/1682U Terminator Resistor Reference

3.3 Card Installation

**Note!** Make sure you have installed the driver before installing the card. We strongly recommend that you install the software driver before installing the hardware into your system, since this will guarantee a smooth and trouble-free installation process.

**Warning!** Turn off your PC's power supply whenever you install or remove the PCI communication card or its cables. Static electricity can easily damage computer equipment. Ground yourself by touching the chassis of the computer (metal) before you touch any boards.

1. Turn off the computer.
2. Turn the power off to any peripheral devices (such as printers and monitors).
3. Disconnect the power cord and any other cables from the back of the computer.
4. Turn the PC if necessary to gain access to the cables.
5. Remove the PC's cover (refer to your user's guide if necessary).
6. Locate the expansion slots or passive back-plane (at the rear of the PC) and choose any unused slot.
7. Remove the screw that secures the expansion slot cover to the PC (save the screw to secure the interface card retaining bracket).
8. Remove the anti-vibration card clamp if supplied.
9. Carefully grasp the upper edge of the PCI communication card.
10. Align the hole in the retaining bracket with the hole on top of the expansion slot.
11. Align the gold striped edge connector with the expansion slot socket.
12. Press the board firmly into the socket.
13. Replace the screw in the expansion slot's retaining bracket.
15. Replace the PC's cover. Connect the cables you removed in step 3.
16. Turn the computer power on.
17. The board is now installed in the computer. See Chapter 5 for information on cabling.
Chapter 4

Software Requirements

This chapter has information on the software of PCI-1680U/1682U.
4.1 Introduction

PCI-1680U/1682U and PCL-841 are Isolated Dual-port CAN communication cards. Each provides two isolated CAN ports for communication applications in difficult environments. The chip on the CAN cards is SJA1000. The SJA1000 is a single chip solution for PC-based CAN port and parallel expansion add-in cards.

This chapter outlines the CAN card's windows DLL driver software requirement specifications. Including functionality, performance, and user interface requirements. It applies to programming the CAN cards Windows unified DLL driver, including the driver for PCL841 and PCI1680.

4.1.1 Definitions, Acronyms, and Abbreviations

SRS = Software Requirements Specification
PPI = Programmable Peripheral Interface
GUI = Graphics User Interface

4.1.2 Reference

Please see "SJA1000.pdf" on your CD-ROM for further information on the SJA1000 chip.

4.2 Overview of Advantech CAN Windows WDM&CE Driver

Advantech CAN Windows WDM&CE Driver is composed of bus drivers, ports drivers, tools and examples. Bus drivers and ports drivers, which run in PeliCAN mode, are used to drive SJA1000 chip on Advantech CAN device. Bus drivers and ports drivers are compliant with PCI and ISA bus, and provide the users with coherent operation interfaces. Users can directly write applications with windows API. Examples of VC, VB, VB.NET, C#.NET, VC.NET, eVC are supplied in the package, providing a reference for users to develop applications. When developing work is completed, users can use test tools to verify if functions of the application are correct.

Features

- Supports CAN 2.0B Protocol and compatible with CAN 2.0A Protocol, which means both Standard frame and Extended frame can be dealt with.
- Supports single filter mode and dual filter mode.
- Supports Listen-Only Mode.
- Supports self reception mode on WDM platform.
- Provides API interface similar to windows standard serial port, easy to develop.
- Provides tools like CANTest, CANDemo to test the basic functions.
- Provides CANMonitor to monitor CAN/CANopen network. A maximum of 1000000 frame data can be reserved a time and meanwhile CAN/CANopen messages can be dealt with.
- Provides interface COTI.DLL of CANopen Conformance Test Tool. The COTI DLL allows users to use the CANopen Conformance Test Tool of CiA(CAN in Automation) with Advantech CAN WDM Driver.
CAN 2.0A and CAN 2.0B
CAN2.0 Spec. includes CAN 2.0A and CAN 2.0B. CAN 2.0A supports standard 11 bit Identifier. CAN 2.0B supports both 11 bit Identifier and extended 29 bit Identifier. So CAN 2.0B are compatible with CAN 2.0A.

SJA1000
SJA1000 supports BasicCAN mode and PeliCAN mode. BasicCAN mode supports CAN 2.0A, while PeliCAN mode supports 2.0B. Advantech CAN Windows WDM&CE Driver runs in PeliCAN mode, thus it can support both Standard frame and Extended frame.

System Requirements

The usage of WDM is different from that of CE in the following aspects:
- **Driver Installation**
  - WDM: The user should refer to Install WDM Driver to install the driver.
  - CE: The driver has been pre-built in Platform image, so the user doesn't need to install the driver.
- **Development Kit Installation**
  - WDM: none
  - CE: Advantech platform SDK
- **Function**
  - WDM: Support all the functions listed in the manual.
  - CE: Not support self reception function.

Interface
The interfaces that WDM and CE support are almost the same.
The user should pay attention to the following differences:
1. The device name is different.
   Here CAN1 is used as an example:
   - WDM: \\.\\CAN1
   - CE: CAN1:
     Functions involved: CreateFile
2. Since OVERLAPPED type is not supported by CE, NULL pointers will be loaded instead of parameters using OVERLAPPED structure.
   Functions involved:DeviceIoControl, ReadFile, WriteFile, WaitCommEvent.
3. OVERLAPPED type is not supported by CE, so does not support GetOverLappedResult function.
Hardware Support

Table 4.1: Hardware Support

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Description</th>
<th>WDM</th>
<th>CE</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCM-3680</td>
<td>2 port Isolated ISA CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PCL-841</td>
<td>2 port Isolated ISA CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TPC-662G</td>
<td>1 port Isolated ISA CAN bus Device on TPC-662G.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PCI-1680</td>
<td>2 port Isolated PCI CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>UNO-2052(E)</td>
<td>2 port Isolated PCI CAN bus Device on UNO-2052(E).</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>EAMB-PH07</td>
<td>1 port Isolated PCI CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TPC-68T</td>
<td>1 port Isolated ISA CAN bus Device on TPC-68T.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TPC-120H</td>
<td>1 port Isolated ISA CAN bus Device on TPC-120H.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TPC-32T</td>
<td>1 port Isolated ISA CAN bus Device on TPC-32T.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>AMAX-2050</td>
<td>1 port Isolated PCI CAN bus Device on AMAX-2050.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>ADAM-5095</td>
<td>2 port Isolated PCI CAN bus Card.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (1 PORT)</td>
<td>1 port Isolated PCI CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (2 PORT)</td>
<td>2 port Isolated PCI CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (4 PORT)</td>
<td>4 port Isolated PCI CAN bus Card.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (1 PORT, support CANopen)</td>
<td>1 port Isolated PCI CAN bus Card and support CANopen.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (2 PORT, support CANopen)</td>
<td>2 port Isolated PCI CAN bus Card and support CANopen.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ADVANTECH GENERAL CAN PORT (4 PORT, support CANopen)</td>
<td>4 port Isolated PCI CAN bus Card and support CANopen.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Users of Windows CE can refer to Guide for developing applications

References

"SJA1000 Standard-alone CAN controller"
4.3 Introduction to API

Main API used in current development are:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateFile</td>
<td>Open specified CAN port.</td>
</tr>
<tr>
<td>CloseHandle</td>
<td>Close specified CAN port.</td>
</tr>
<tr>
<td>DeviceIoControl</td>
<td>Send commands to drivers, including configuration, management and getting status, etc.</td>
</tr>
<tr>
<td>ReadFile</td>
<td>Read data.</td>
</tr>
<tr>
<td>WriteFile</td>
<td>Send data.</td>
</tr>
<tr>
<td>GetOverLappedResult</td>
<td>Wait until asynchronous operation is finished.</td>
</tr>
<tr>
<td>SetCommMask</td>
<td>Set mask.</td>
</tr>
<tr>
<td>GetCommMask</td>
<td>Get mask.</td>
</tr>
<tr>
<td>WaitCommEvent</td>
<td>Wait specified event.</td>
</tr>
<tr>
<td>ClearCommError</td>
<td>Get error code with this function when receiving error event.</td>
</tr>
</tbody>
</table>

Only brief introduction is given in this manual regarding detailed usage of each function. Notes are made to notify users of important operation. For more detailed information about the usage, please see MSDN.

4.3.1 CreateFile

Users can use this interface to open CAN port device.

Close the port by calling CloseHandle when operation is completed.

*Note! This driver does not support share open function, so the third parameter must be set to 0.*

**Syntax**

```c
HANDLE CreateFile(
    LPCTSTR lpFileName, 
    DWORD dwDesiredAccess, 
    DWORD dwShareMode, 
    LPSECURITY_ATTRIBUTES lpSecurityAttributes, 
    DWORD dwCreationDisposition, 
    DWORD dwFlagsAndAttributes, 
    HANDLE hTemplateFile
);
```
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lpFileName</td>
<td>Input</td>
<td>Name of device which was opened, such as \.\CAN1. *Note In WINDOWS CE, use CAN1:</td>
</tr>
<tr>
<td>ldwDesiredAccess</td>
<td>Input</td>
<td>Ways of opening the port, which is usually GENERIC_READ</td>
</tr>
<tr>
<td>dwShareMode</td>
<td>Input</td>
<td>Does not support share open. It must be set to 0.</td>
</tr>
<tr>
<td>lpSecurityAttributes</td>
<td>Input</td>
<td>NULL.</td>
</tr>
<tr>
<td>dwCreationDisposition</td>
<td>Input</td>
<td>OPEN_EXISTING.</td>
</tr>
<tr>
<td>dwFlagsAndAttributes</td>
<td>Input</td>
<td>Synchronous open: FILE_ATTRIBUTE_NORMAL. Asynchronous open:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FILE_ATTRIBUTE_NORMAL</td>
</tr>
<tr>
<td>hTemplateFile</td>
<td>Input</td>
<td>NULL.</td>
</tr>
</tbody>
</table>

Return Value

Successful, return effective HANDLE. Unsuccessful, return INVALID_HANDLE_VALUE.

Example

Synchronous open CAN1:
HANDLE hDevice = CreateFile(
    \\.\\CAN1",
    GENERIC_READ | GENERIC_WRITE,
    0,
    NULL,
    OPEN_EXISTING,
    FILE_ATTRIBUTE_NORMAL,
    NULL);

Asynchronous open CAN1:
HANDLE hDevice = CreateFile(
    \\.\\CAN1",
    GENERIC_READ | GENERIC_WRITE,
    0,
    NULL,
    OPEN_EXISTING,
    FILE_ATTRIBUTE_NORMAL|FILE_FLAG_OVERLAPPED,
    NULL);
### 4.3.2 CloseHandle

Close the port by calling this function when operation is completed.

**Syntax**

```c
BOOL CloseHandle(
    HANDLE hDevice
);
```

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
</tbody>
</table>

**Return Value**

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.

**Example**

```c
//close
    BOOL bRet = CloseHandle(hDevice);
```

**See Also**

CreateFile

### 4.3.3 DeviceIoControl

Users can use this interface to send commands, configure ports, like stop device, start device, configure Baud Rate, etc.

See Command_par, CanStatusPar_t for detailed configuration.

**Syntax**

```c
BOOL DeviceIoControl(
    HANDLE hDevice,
    DWORD dwIoControlCode,
    LPVOID lpInBuffer,
    DWORD nInBufferSize,
    LPVOID lpOutBuffer,
    DWORD nOutBufferSize,
    LPDWORD lpBytesReturned,
    LPOVERLAPPED lpOverlapped
);
```
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>dwIoControlCode</td>
<td>Input</td>
<td>Control code, shows the specific operation mode.</td>
</tr>
<tr>
<td>lpInBuffer</td>
<td>Input</td>
<td>Start address sent to data area of driver.</td>
</tr>
<tr>
<td>nlInBufferSize</td>
<td>Input</td>
<td>Byte length sent to data area of driver.</td>
</tr>
<tr>
<td>lpOutBuffer</td>
<td>Output</td>
<td>Address of data area which receives driver's return data.</td>
</tr>
<tr>
<td>nOutBufferSize</td>
<td>Input</td>
<td>Byte length of data area which receives driver's return data.</td>
</tr>
<tr>
<td>lpBytesReturned</td>
<td>Output</td>
<td>Real byte length of data received from driver.</td>
</tr>
<tr>
<td>lpOverlapped</td>
<td>Input</td>
<td>If CreateFile uses asynchronous open, asynchronous operation must be supported here. Please refer to MSDN for detailed instruction to asynchronous open.</td>
</tr>
</tbody>
</table>

*Note In WINDOWS CE, set to NULL.*

Return Value

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.

It will be considered unsuccessful if zero values are returned in the following situation. Please call GetLastError.
In work mode, drivers can not complete some of the requests, GetLastError will be called to return ERROR_GEN_FAILURE.

Example

Set baud rate:

```c
DWORD dwReturned;
Command_par_t cmd;
Config_par_t config;
cmd.cmd = CMD_STOP;

BOOL bSuccess = DeviceIoControl ( 
    hDevice,
    CAN_IOCTL_COMMAND,
    &cmd,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
);
if(!bSuccess)
{
    //error
}

config.target = CONF_TIMING;
config.vall = 1000; //set 1000K
```
bSuccess = DeviceIoControl ( 
    hDevice,
    CAN_IOCTL_CONFIG,
    &config,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
);
if(!bSuccess)
{
    //error
}

cmd.cmd = CMD_START;
bSuccess = DeviceIoControl ( 
    hDevice,
    CAN_IOCTL_COMMAND,
    &cmd,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
);
if(!bSuccess)
{
    //error
}

- **Set acceptance filter:**

  DWORD dwReturned;
  Command_par_t cmd;
  Config_par_t config;
  cmd.cmd = CMD_STOP;

  BOOL bSuccess = DeviceIoControl ( 
    hDevice,
    CAN_IOCTL_COMMAND,
    &cmd,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
  );
  if(!bSuccess)
  {
  }
config.target = CONF_ACC_FILTER;
config.val1 = 1; // 1: set single filter mode; 0: set dual filter mode

bSuccess = DeviceIoControl (hDevice,
CAN_IOCTL_CONFIG,
&config,
sizeof(Command_par),
NULL,
0,
&dwReturned,
NULL);
if(!bSuccess)
{
    // error
}
config.target = CONF_ACC;
config.val1 = 0xffffffff;
config.val2 = 0xffffffff;
bSuccess = DeviceIoControl (hDevice,
CAN_IOCTL_CONFIG,
&config,
sizeof(Command_par),
NULL,
0,
&dwReturned,
NULL);
if(!bSuccess)
{
    // error
}

cmd.cmd = CMD_START;
bSuccess = DeviceIoControl (hDevice,
CAN_IOCTL_COMMAND,
&cmd,
sizeof(Command_par),
NULL,
0,
&dwReturned,
NULL)
Set listen only mode:

DWORD dwReturned;
Command_par_t cmd;
Config_par_t config;

cmd.cmd = CMD_STOP;

BOOL bSuccess = DeviceIoControl (
    hDevice,
    CAN_IOCTL_COMMAND,
    &cmd,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
);

if(!bSuccess)
{
    //error
}

config.target = CONF_LISTEN_ONLY_MODE;
config.val1 = 1; //1: ON; 0: OFF

bSuccess = DeviceIoControl (
    hDevice,
    CAN_IOCTL_CONFIG,
    &config,
    sizeof(Command_par),
    NULL,
    0,
    &dwReturned,
    NULL
);

if(!bSuccess)
{
    //error
}

cmd.cmd = CMD_START;
bSuccess = DeviceIoControl (
    hDevice,
    CAN_IOCTL_COMMAND,
    &cmd,
sizeof(Command_par),
NULL,
0,
&dwReturned,
NULL
);
if(!bSuccess)
{
    //error
}
Reset chip:
DWORD dwReturned;
Command_par_t cmd;

    cmd.cmd = CMD_RESET;

    BOOL bSuccess = DeviceIoControl ( 
        hDevice,
        CAN_IOCTL_COMMAND,
        &cmd,
        sizeof(Command_par),
        NULL,
        0,
        &dwReturned,
        NULL
    );
    if(!bSuccess)
    {
        //error
    }

    cmd.cmd = CMD_START;
    bSuccess = DeviceIoControl ( 
        hDevice,
        CAN_IOCTL_COMMAND,
        &cmd,
        sizeof(Command_par),
        NULL,
        0,
        &dwReturned,
        NULL
    );
    if(!bSuccess)
    {
        //error
    }
**Clear receive buffer:**

DWORD dwReturned;
Command_par_t cmd;
  cmd.cmd = CMD_CLEARBUFFERS;

BOOL bSuccess = DeviceIoControl (  
  hDevice,  
  CAN_IOCTL_COMMAND,  
  &cmd,  
  sizeof(Command_par),  
  NULL,  
  0,  
  &dwReturned,  
  NULL  
);
  if(!bSuccess)  
  {  
    //error  
  }  

Get status of device:
DWORD dwReturned;
CanStatusPar_t status;

BOOL bSuccess = DeviceIoControl (  
  hDevice,  
  CAN_IOCTL_STATUS,  
  NULL,  
  0,  
  &status,  
  sizeof(CanStatusPar_t),  
  &dwReturned,  
  NULL  
);

**See Also**
Command_par  
CanStatusPar_t
4.3.4 **ReadFile**

Users can use this interface to read data from CAN port which was opened. One or more frames can be selected each time.

**Note!** The third and fourth parameters of ReadFile are defined as byte length in MSDN, but stand for the number of frames in Advantech CAN Windows WDM&CE Driver.

**Syntax**

```c
BOOL ReadFile(
    HANDLE hDevice,
    LPVOID lpBuffer,
    DWORD nNumberOfFramesToRead,
    LPDWORD lpNumberOfFramesRead,
    LPOVERLAPPED lpOverlapped
);
```

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpBuffer</td>
<td>Output</td>
<td>Start address of receive buffer.</td>
</tr>
<tr>
<td>nNumberOfFramesToRead</td>
<td>Input</td>
<td>Number of frames to be received from drivers. The definition here is different from that in MSDN.</td>
</tr>
<tr>
<td>lpNumberOfFramesRead</td>
<td>Output</td>
<td>Real number of frames received from driver. The definition here is different from that in MSDN.</td>
</tr>
<tr>
<td>lpOverlapped</td>
<td>Input</td>
<td>If CreateFile uses asynchronous open, asynchronous operation must be supported here. Please refer to MSDN for detailed instruction to asynchronous open.</td>
</tr>
</tbody>
</table>

*Note In WINDOWS CE, set to NULL.*
Return Value
It will be considered successful if non-zero values are returned in the following situations:
1. The driver reads data and there is no data in the receive buffer. At this time, the data received is less than the requested data.
2. The driver reads all the requested data.
3. The driver can not read any data and time is out.

It will be considered unsuccessful if zero values are returned in the following situations. Please call GetLastError.

If users cancel the operation or reset chip while drivers are receiving data, GetLastError will be called to return ERROR_OPERATION_ABORTED.

If busoff of device is discovered before drivers read any frames, GetLastError will be called to return ERROR_GEN_FAILURE.

If drivers cannot allocate resources according to the number defined by the third parameter frame, GetLastError will be called to return ERROR_INVALID_PARAMETER.

In asynchronous mode, operation will be pending if drivers cannot complete user's read request, and GetLastError will be called to return ERROR_IO_PENDING.

See MSDN for more information.

Example
Read one frame data in synchronous mode.

```
DWORD dwRead;
canmsg_t ReadBuffer;
ZeroMemory(&ReadBuffer, sizeof(canmsg_t));
BOOL bSuccess = ReadFile(hDevice, &ReadBuffer, 1, &dwRead, 0);
if(bSuccess)
{
    if(dwRead == 1)
    {
        //SUCCESS
        if(ReadBuffer.flags & MSG_EXT)
        {
            //Extended frame
        }
        else{
            //Standard frame
        }
        if(ReadBuffer.flags & MSG_RTR)
        {
            //Remote frame
        }
        if(ReadBuffer.flags & MSG_SELF)
        {
            //self reception
        }
        if(ReadBuffer.flags & MSG_BOVR)
    }
```
{  
  //receive buffer overflow
}
if(ReadBuffer.flags & MSG_BUSOFF)
{
  //CAN controller bus off
}
if(ReadBuffer.flags & MSG_OVR)
{
  //CAN controller Msg overflow error
}
if(ReadBuffer.flags & MSG_PASSIVE)
{
  //CAN controller in error passive
}
else{
  //Timeout
}
else{
  DWORD dwError = GetLastError();
  if (dwError == ERROR_IO_PENDING)
  {
    //pending
  }
  else if (dwError == ERROR_INVALID_PARAMETER)
  {
    //parameter error
  }
  else if (dwError == ERROR_OPERATION_ABORTED)
  {
    //cancelled
  }
  else if (dwError == ERROR_GEN_FAILURE)
  {
    //bus off
  }
}
4.3.5 WriteFile

Users can use this interface to send data to CAN port which was opened. One or more frames can be selected each time.

**Note!** The third and fourth parameters of WriteFile are defined as byte length in MSDN, but stand for the number of frames here.

**Syntax**

```c
BOOL WriteFile(
    HANDLE hDevice,
    LPCVOID lpBuffer,
    DWORD nNumberOfFramesToWrite,
    LPDWORD lpNumberOfFramesWritten,
    LPOVERLAPPED lpOverlapped
);
```

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpBuffer</td>
<td>Input</td>
<td>Start address of send buffer.</td>
</tr>
<tr>
<td>nNumberOfFramesToWrite</td>
<td>Input</td>
<td>Number of frames to be sent to drivers. The definition here is different from that in MSDN.</td>
</tr>
<tr>
<td>lpNumberOfFramesWritten</td>
<td>Output</td>
<td>Real number of frames sent to driver. The definition here is different from that in MSDN.</td>
</tr>
<tr>
<td>lpOverlapped</td>
<td>Input</td>
<td>If CreateFile uses asynchronous open, asynchronous operation must be supported here. Please refer to MSDN for detailed instruction to asynchronous open.</td>
</tr>
</tbody>
</table>

*Note In WINDOWS CE,set to NULL.

**Return Value**

It will be considered successful if non-zero values are returned in the following situations:

- Driver send all the requested data.
- Timeout occur when driver only send part of the data or no data.

It will be considered unsuccessful if zero values are returned in the following situations. Please call GetLastError.

- If user cancel the operation or reset chip while drivers are sending data, GetLastError will be called to return ERROR_OPERATION_ABORTED.
- If busoff of device is discovered before drivers send any frames, GetLastError will be called to return ERROR_GEN_FAILURE.
- If drivers cannot allocate resources according to the number defined by the third parameter frame, GetLastError will be called to return ERROR_INVALID_PARAMETER.
In asynchronous mode, operation will be pending if drivers cannot complete user's write request at present, and GetLastError will be called to return ERROR_IO_PENDING.
See MSDN for more information.

Example
Write one frame data in synchronous mode.

```c
DWORD dwWrite;
canmsg_t WriteBuffer;
ZeroMemory(&WriteBuffer, sizeof(canmsg_t));

//WriteBuffer.flags = 0; //Standard frame
WriteBuffer.flags = MSG_EXT; //Extended frame
//WriteBuffer.flags |= MSG_RTR; //Remote frame

WriteBuffer.id = 0;
WriteBuffer.length = DATALENGTH;

for(int i=0; i<DATALENGTH; i++)
{
    WriteBuffer.data[i] = i;
}

BOOL bSuccess = WriteFile(hDevice, &WriteBuffer, 1, &dwWrite, 0);
if(bSuccess)
{
    if(dwWrite == 1)
    {
        //SUCCESS
    }
    else{
        //Timeout
    }
}
else{
    DWORD dwError = GetLastError();

    if (dwError == ERROR_IO_PENDING)
    {
        //pending
    }
    else if(dwError == ERROR_INVALID_PARAMETER)
    {
        //parameter error
    }
    else if(dwError == ERROR_OPERATION_ABORTED)
    {
        //cancelled
    }
    else if(dwError == ERROR_GEN_FAILURE)
    {
        //bus off
    }
}
```
4.3.6 **SetCommMask**

Users can use this interface to set event for CAN port. Users have to call WaitCommEvent function to wait event. Users can call GetCommMask to get the current event set before. If users do not set any of the supported event types, the real event type will be zero. In this case, if WaitCommEvent is called, the call will be returned and the event type returned will be zero.

*Note!* Events supported at present are only:

<table>
<thead>
<tr>
<th>Type</th>
<th>Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>EV_ERR</td>
<td>Error</td>
</tr>
<tr>
<td>EV_RXCHAR</td>
<td>Receive one frame data</td>
</tr>
</tbody>
</table>

**Syntax**

```c
BOOL SetCommMask(
    HANDLE hDevice,
    DWORD dwEvtMask
);
```

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>dwEvtMask</td>
<td>Input</td>
<td>Event type.</td>
</tr>
</tbody>
</table>

**Return Value**

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.

**Example**

```c
BOOL bSuccess = SetCommMask(hDevice, EV_ERR | EV_RXCHAR);
```

**See Also**

WaitCommEvent
GetCommMask
4.3.7 GetCommMask

Users can call GetCommMask to get event type set in SetCommMask.

Syntax

```c
BOOL GetCommMask(
    HANDLE hDevice,
    LPDWORD lpEvtMask
);
```

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpEvtMask</td>
<td>Output</td>
<td>Store event type which return from drivers.</td>
</tr>
</tbody>
</table>

Return Value

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.

Example

```c
DWORD dwMask = 0;
BOOL bSuccess = GetCommMask(hDevice, &dwMask);
```

See Also

SetCommMask

4.3.8 WaitCommEvent

After calling SetCommMask to set event, users should also call WaitCommEvent function to wait event.

Syntax

```c
BOOL WaitCommEvent(
    HANDLE hDevice,
    LPDWORD lpEvtMask,
    LPOVERLAPPED lpOverlapped
);
```

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpEvtMask</td>
<td>Output</td>
<td>Event type.</td>
</tr>
<tr>
<td>lpOverlapped</td>
<td>Output</td>
<td>If CreateFile uses asynchronous open, asynchronous operation must be supported here. Please refer to MSDN for detailed instruction to asynchronous open. *Note In WINDOWS CE, set to NULL.</td>
</tr>
</tbody>
</table>
Return Value
Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.
If users cancel the operation or reset chip, GetLastError will be called to return ERROR_OPERATION_ABORTED.
In asynchronous mode, operation will be pending if drivers cannot complete user's request, and GetLastError will be called to return ERROR_IO_PENDING.
See MSDN for more information.

Example
Wait event in synchronous mode.

```c
BOOL bSuccess = SetCommMask(hDevice, EV_ERR | EV_RXCHAR);
if(!bSuccess)
{
    //error
}
DWORD dwMask = 0;
bSuccess = WaitCommEvent(hDevice, &dwMask, NULL);
if(bSuccess)
{
    if(dwMask & EV_ERR)
    {
        //to do
        DWORD dwError;
        ClearCommError(hDevice, &dwError, NULL);
    }
    if(dwMask & EV_RXCHAR)
    {
        //to do
    }
}
```

See Also
SetCommMask
ClearCommError
4.3.9 **ClearCommError**

When error occurs, users can use ClearCommError to get the specific type of error.

**Note!** Definitions of error codes supported are as below:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_RXOVER</td>
<td>Receive Queue overflow.</td>
</tr>
<tr>
<td>CE_OVERRUN</td>
<td>Receive Overrun Error.</td>
</tr>
<tr>
<td>CE_FRAME</td>
<td>Passive error.</td>
</tr>
<tr>
<td>CE_BREAK</td>
<td>Busoff.</td>
</tr>
</tbody>
</table>

**Note!** The third parameter is unused, please set it to NULL.

**Syntax**

```c
BOOL ClearCommError(
    HANDLE hDevice,
    LPDWORD lpErrors,
    LPCOMSTAT lpStat
);
```

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpErrors</td>
<td>Output</td>
<td>Store error codes which return from drivers.</td>
</tr>
<tr>
<td>lpStat</td>
<td>Output</td>
<td>Empty. If users want to know specific information about error register, please call DeviceIoControl to get status of the device.</td>
</tr>
</tbody>
</table>

**Return Value**

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.
Example
Wait event in synchronous mode.

```c
DWORD dwMask;
BOOL bSuccess = WaitCommEvent(hDevice, &dwMask, NULL);
if(bSuccess)
{
    if(dwMask & EV_ERR)
    {
        //to do
        DWORD dwError;
        bSuccess = ClearCommError(hDevice, &dwError, NULL);
        if(bSuccess)
        {
            //to do
            if(dwError & CE_FRAME || dwError & CE_BREAK)
            {
                CanStatusPar_t status;
                DWORD dwReturned;
                DeviceIoControl (hDevice,
                CAN_IOCTL_STATUS,
                NULL,
                0,
                &status,
                sizeof(CanStatusPar_t),
                &dwReturned,
                NULL
            );
        }
    }
}
```

See Also
WaitCommEvent
DeviceIoControl
4.3.10 GetOverlappedResult

When user's operation cannot be finished immediately in asynchronous mode, this function should be called to wait operation to be completed.

Syntax

```c
BOOL GetOverlappedResult(
    HANDLE hDevice,
    LPOVERLAPPED lpOverlapped,
    LPDWORD lpNumberOfFramesTransferred,
    BOOL bWait
);
```

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hDevice</td>
<td>Input</td>
<td>Handle of the device which was opened.</td>
</tr>
<tr>
<td>lpOverlapped</td>
<td>Input</td>
<td>Events need to be waited are included. Refer to MSDN for more information.</td>
</tr>
<tr>
<td>lpNumberOfFramesTransferred</td>
<td>Output</td>
<td>ReadFile and WriteFile are real numbers of data written and read;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WaitCommEvent is not defined.</td>
</tr>
<tr>
<td>bWait</td>
<td>Input</td>
<td>TRUE, will not return until read/write operation is finished. FALSE,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>return immediately no matter the operation is finished or not. Call</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GetLastError to return ERROR_IO_INCOMPLETE. Refer to MSDN for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>detailed information.</td>
</tr>
</tbody>
</table>

Return Value

Successful: return non-zero values. Unsuccessful: return zero value. Please call GetLastError function.

Example

```c
#include <windows.h>
#include <stdio.h>

void main( )
{
    HANDLE hDevice;
    OVERLAPPED ov;
    BOOL bSuccess;
    DWORD dwEvtMask;
    DWORD dwLength;

    hDevice = CreateFile( "\\\\.\\\CAN1",
        GENERIC_READ | GENERIC_WRITE,
        0, // exclusive access
        NULL, // default security attributes
        OPEN_EXISTING,
        FILE_FLAG_OVERLAPPED,
        NULL
    );
```
if (hDevice == INVALID_HANDLE_VALUE) {
    // Handle the error.
    printf("CreateFile failed with error %d.\n", GetLastError());
    return;
}

// Set the event mask.

bSuccess = SetCommMask(hDevice, EV_ERR | EV_RXCHAR);

if (!bSuccess) {
    // Handle the error.
    printf("SetCommMask failed with error %d.\n", GetLastError());
    return;
}

// Create an event object for use by WaitCommEvent.

ov.hEvent = CreateEvent(
    NULL, // default security attributes
    FALSE, // auto reset event
    FALSE, // not signaled
    NULL  // no name
);

    // Initialize the rest of the OVERLAPPED structure to zero.

ov.Internal = 0;
ov.InternalHigh = 0;
ov.Offset = 0;
ov.OffsetHigh = 0;

if (WaitCommEvent(hDevice, &dwEvtMask, &ov)) {
    if (dwEvtMask & EV_ERR)
    {
        // To do.
    }

    if (dwEvtMask & EV_RXCHAR)
    {
        // To do.
    }


```c

else
{
    DWORD dwRet = GetLastError();
    if( ERROR_IO_PENDING == dwRet)
    {
        printf("I/O is pending...
");
        if(GetOverlappedResult(hDevice, &ov, &dwLength,
            TRUE))
        {
            //To do
        }
        else
        {
            //To do
        }
    }
    else
    {
        printf("Wait failed with error %d.
", GetLastError());
    }
}

See Also
ReadFile WriteFile
WaitCommEvent

4.4 Structure List

The table below is a list of structures needed by Advantech CAN WDM Driver.

Methods:

<table>
<thead>
<tr>
<th>Structure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>canmsg_t</td>
<td>Received/Sent message structure.</td>
</tr>
<tr>
<td>CanStatusPar_t</td>
<td>Port status structure.</td>
</tr>
<tr>
<td>Command_par</td>
<td>Command/Configure operation structure.</td>
</tr>
</tbody>
</table>
4.4.1 canmsg_t

When users directly use ReadFile or WriteFile interface of Windows Native API to call drivers, this structure is needed.

```c
typedef struct {
    int       flags;
    int       cob;
    ULONG     id;
    short int length;
    UCHAR     data[8];
} canmsg_t;
```

### Member Description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flags</td>
<td>Types of messages.</td>
</tr>
<tr>
<td>cob</td>
<td>Reserved.</td>
</tr>
<tr>
<td>id</td>
<td>ID of message.</td>
</tr>
<tr>
<td>length</td>
<td>ID of messages (0~8).</td>
</tr>
<tr>
<td>data</td>
<td>Data transferred (Made up of 0~8 Byte data).</td>
</tr>
</tbody>
</table>

### Remarks

8-bit flags are used to record types of messages during sending or receiving. The meanings of these bits are:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Declaration</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>MSG_RTR</td>
<td>RTR</td>
<td>1 means Remote frame, 0 means data frame.</td>
</tr>
<tr>
<td>1</td>
<td>MSG_OVR</td>
<td>Hardware OVER-RUN</td>
<td>1 means receive buffer overrun of hardware.</td>
</tr>
<tr>
<td>2</td>
<td>MSG_EXT</td>
<td>Extension</td>
<td>1 means Extended frame(29 bit identifier), 0 means Standard frame(11 bit identifier).</td>
</tr>
<tr>
<td>3</td>
<td>MSG_SELF</td>
<td>Self Reception</td>
<td>1 means self sending and receiving frame, 0 means receiving frame from other ports.</td>
</tr>
<tr>
<td>4</td>
<td>MSG_PASSIVE</td>
<td>Error</td>
<td>1 means bus error.</td>
</tr>
<tr>
<td>5</td>
<td>MSG_BUSOFF</td>
<td>BUSOFF</td>
<td>1 means busoff.</td>
</tr>
<tr>
<td>6</td>
<td>Reserved</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>MSG_BOVR</td>
<td>Software OVERRUN</td>
<td>1 means receive buffer overrun of software.</td>
</tr>
</tbody>
</table>

ID shows type of CAN. When ID is 0xFFFFFFFF, it means error frame, which implies that hardware overrun, error and busoff occur in drivers. Users can get the specific type from flags.

If ID does not equal 0xFFFFFFFF, flags may be Remote frame, Extended frame, Standard frame, Self Reception or software overrun.
4.4.2 CanStatusPar_t

DeviceIOControl's parameter dwIoControlCode is CAN_IOCTL_STATUS (0x222554). It uses this structure.

```c
typedef struct {
    unsigned int baud;
    unsigned int status;
    unsigned int error_warning_limit;
    unsigned int rx_errors;
    unsigned int tx_errors;
    unsigned int error_code;
    unsigned int rx_buffer_size;
    unsigned int rx_buffer_used;
    unsigned int tx_buffer_size;
    unsigned int tx_buffer_used;
    ULONG retval;
    unsigned int type;
    unsigned int acceptancecode;
    unsigned int acceptance_mask;
    unsigned int acceptance_mode;
    unsigned int selfreception;
    unsigned int readtimeout;
    unsigned int writetimeout;
} CanStatusPar_t, *PCanStatusPar_t;
```

### Member Description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>baud</td>
<td>Actual bit rate.</td>
</tr>
<tr>
<td>status</td>
<td>The status register (SR); CAN address 2.</td>
</tr>
<tr>
<td>error_warning_limit</td>
<td>The error warning limit register (EWLR); CAN address 13.</td>
</tr>
<tr>
<td>rx_errors</td>
<td>The RX error counter register (RXERR); CAN address 14.</td>
</tr>
<tr>
<td>tx_errors</td>
<td>The TX error counter register (TXERR); CAN address 15.</td>
</tr>
<tr>
<td>error_code</td>
<td>The error code capture register (ECC); CAN address 12.</td>
</tr>
<tr>
<td>rx_buffer_size</td>
<td>Size of rx buffer.</td>
</tr>
<tr>
<td>rx_buffer_used</td>
<td>Number of received messages.</td>
</tr>
<tr>
<td>tx_buffer_size</td>
<td>Size of tx buffer for wince.</td>
</tr>
<tr>
<td>tx_buffer_used</td>
<td>Number of messages of tx buffer for wince.</td>
</tr>
<tr>
<td>retval</td>
<td>Return Value. 0, SUCCESS; 0xFFFFFFFF, FAIL.</td>
</tr>
<tr>
<td>type</td>
<td>CAN controller type. 1, SJA1000; 0 other device.</td>
</tr>
<tr>
<td>acceptancecode</td>
<td>Acceptance code.</td>
</tr>
<tr>
<td>acceptance_mask</td>
<td>Acceptance mask.</td>
</tr>
<tr>
<td>acceptance_mode</td>
<td>Acceptance Filter Mode: 1:Single 0:Dual.</td>
</tr>
<tr>
<td>selfreception</td>
<td>Self reception.</td>
</tr>
<tr>
<td>ReadTimeout</td>
<td>Read timeout.</td>
</tr>
<tr>
<td>WriteTimeout</td>
<td>Write timeout.</td>
</tr>
</tbody>
</table>
4.4.3 **Command_par**

When users directly use DeviceIOControl interface of Windows Native API to call drivers, this structure is needed.

If DeviceIOControl's parameter dwIoControlCode is CAN_IOCTL_COMMAND (0x222540), this means command operation. If dwIoControlCode is CAN_IOCTL_CONFIG (0x222544), it means configuration operation. (Please refer to MSDN for related information about DeviceIOControl).

```c
struct Command_par {
    int cmd;
    int target;
    ULONG val1;
    ULONG val2;
    int error;
    ULONG retval;
};
```

**Note**

1. The two modes of configuring Baud Rate are standard mode and custom mode.

   - **Standard mode**
     The standard mode includes the recommended Baud Rate value. If the setting value is 10, then the Baud Rate will be 10k.

<table>
<thead>
<tr>
<th>Target value</th>
<th>BTR0</th>
<th>BTR1</th>
<th>Setting value</th>
</tr>
</thead>
<tbody>
<tr>
<td>10K</td>
<td>0x31</td>
<td>0x1c</td>
<td>10</td>
</tr>
<tr>
<td>20K</td>
<td>0x18</td>
<td>0x1c</td>
<td>20</td>
</tr>
<tr>
<td>50K</td>
<td>0x09</td>
<td>0x1c</td>
<td>50</td>
</tr>
<tr>
<td>100K</td>
<td>0x04</td>
<td>0x1c</td>
<td>100</td>
</tr>
<tr>
<td>125K</td>
<td>0x03</td>
<td>0x1c</td>
<td>125</td>
</tr>
<tr>
<td>250K</td>
<td>0x01</td>
<td>0x1c</td>
<td>250</td>
</tr>
<tr>
<td>500K</td>
<td>0x00</td>
<td>0x16</td>
<td>500</td>
</tr>
<tr>
<td>800K</td>
<td>0x00</td>
<td>0x14</td>
<td>800</td>
</tr>
<tr>
<td>1000K</td>
<td>0x00</td>
<td>0x14</td>
<td>1000</td>
</tr>
</tbody>
</table>

- **Custom mode**
  If user need the baud rate is not in above table, user can use the custom mode to set the custom baud rate.
  The CAN port's baud rate is determine by CAN clock, BTR0 and BTR1.
  The Advantech CAN devices use 8MHZ clock and oscillator frequency is 16M, The internal clock is divided by two from the oscillator frequency.

  BTR0 and BTR1 Timing Registers are used for:
  - defining the bit-rate on the bus.
  - defining the sample point in a bit period (bit sample point).
  - defining the number of samples taken in a bit period.

  we provide API function to set BTR0 and BTR1, The function will write the low 8 bits of setting value to BTR0 and high 8 bits of setting value to BTR1 of CAN device register.
The following code is the example to custom baud rate by setting BTR0 and BTR1 device register.

AdvCANIO.h Line:269
/
******************************************************************************
*******
*
* acSetBaudRegister
*
* Purpose:
* Configures baud rate by custom mode.
* *
* *
* Arguments:
* hDevice - handle of device
* Btr0 - BTR0 register value.
* Btr1 - BTR1 register value.
* Returns:
* =0 SUCCESS; or <0 failure
* *
*******************************************************************************/
int acSetBaudRegister(HANDLE hDevice, unsigned char Btr0, unsigned char Btr1)
{
    unsigned int BaudRateValue = Btr0 * 256;
    BaudRateValue += Btr1;
    return acSetBaud(hDevice, BaudRateValue);
}

can_receive.cpp Line:105

    nRet = acSetBaudRegister( hDevice, byBtr0, byBtr1 ); //Set baud rate
    if ( nRet < 0 )
    {
        SetDlgItemText( hwnd, IDC_SHOW_RESULT, "Failed to set Baud Rate!" );
        return FALSE;
    }
User can also refer to receive and send examples for details usage.

How to calculate BTR0 and BTR1, please refer to SJA1000 datasheet for details.

Here we show some value of BTR0 and BTR1 for some custom baud rate.

<table>
<thead>
<tr>
<th>Target value</th>
<th>BTR0</th>
<th>BTR1</th>
<th>Setting value</th>
</tr>
</thead>
<tbody>
<tr>
<td>5K</td>
<td>0xBF</td>
<td>0xFF</td>
<td>0xFFBF</td>
</tr>
<tr>
<td>40K</td>
<td>0x87</td>
<td>0xFF</td>
<td>0xFF87</td>
</tr>
<tr>
<td>80K</td>
<td>0x83</td>
<td>0xFF</td>
<td>0xFF83</td>
</tr>
<tr>
<td>200K</td>
<td>0x81</td>
<td>0xFA</td>
<td>0xFA81</td>
</tr>
<tr>
<td>400K</td>
<td>0x80</td>
<td>0xFA</td>
<td>0xFA80</td>
</tr>
</tbody>
</table>

Please refer to acceptance filtering for setting acceptance code and acceptance mask.
Self reception is not supported on windows CE.

**Member Description**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmd</td>
<td>Send start or stop command to drivers.</td>
</tr>
<tr>
<td>target</td>
<td>Send configure command to drivers.</td>
</tr>
<tr>
<td>val1</td>
<td>Parameter 1.</td>
</tr>
<tr>
<td>val2</td>
<td>Parameter 2.</td>
</tr>
<tr>
<td>error</td>
<td>Reserved.</td>
</tr>
<tr>
<td>retval</td>
<td>Reserved.</td>
</tr>
</tbody>
</table>

**Remarks**

1. While configuring cmd, the following commands are supported:

<table>
<thead>
<tr>
<th>Optional commands</th>
<th>Corresponding value of cmd</th>
<th>Description</th>
<th>val1</th>
<th>val2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_START</td>
<td>1</td>
<td>Start chip and enter work mode.</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
<tr>
<td>CMD_STOP</td>
<td>2</td>
<td>Stop chip and enter reset mode.</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
<tr>
<td>CMD_RESET</td>
<td>3</td>
<td>Stop chip by canceling current send/receive operation and enter reset mode.</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
<tr>
<td>CMD_Clearbuffers</td>
<td>4</td>
<td>Clear receive buffer.</td>
<td>Reserved</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
2. While configuring target, the following commands are supported:

<table>
<thead>
<tr>
<th>Optional configures</th>
<th>Corresponding value of target</th>
<th>Description</th>
<th>val1</th>
<th>val2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF_ACC</td>
<td>0</td>
<td>Acceptance code register and acceptance mask register. Need to enter reset mode.</td>
<td>Acceptance mask register default setting: 0xFFFFFFFF</td>
<td>Acceptance code register default setting: 0xFFFFFFFF</td>
</tr>
<tr>
<td>CONF_ACCM</td>
<td>1</td>
<td>Acceptance mask only. Need to enter reset mode.</td>
<td>Acceptance mask register default setting: 0xFFFFFFFF</td>
<td>Reserved</td>
</tr>
<tr>
<td>CONF_ACCC</td>
<td>2</td>
<td>Acceptance code only. Need to enter reset mode.</td>
<td>Acceptance code register default setting: 0xFFFFFFFF</td>
<td>Reserved</td>
</tr>
<tr>
<td>CONF_TIMING</td>
<td>3</td>
<td>Bit timing. Need to enter reset mode.</td>
<td>Baud Rate default setting: 125k</td>
<td>Reserved</td>
</tr>
<tr>
<td>CONF_LISTEN_ONLY_MODE</td>
<td>8</td>
<td>Listen only mode. Need to enter reset mode.</td>
<td>1: ON; 0: OFF default setting: 0</td>
<td>Reserved</td>
</tr>
<tr>
<td>CONF_SELF_RECEPTIOM</td>
<td>9</td>
<td>Self reception.</td>
<td>1: ON; 0: OFF default setting: 0</td>
<td>Reserved</td>
</tr>
<tr>
<td>CONF_TIMEOUT</td>
<td>13</td>
<td>Configure read and write timeout.</td>
<td>Write timeout (ms) default setting: 5s</td>
<td>Read timeout (ms) default setting: 3s</td>
</tr>
<tr>
<td>CONF_ACC_FILTER</td>
<td>20</td>
<td>Acceptance filter mode: 1-Single, 0-Dual. Need to enter reset mode.</td>
<td>1: Single; 0: Dual default setting: Single</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

4.5 How to dispose message

CAN2.0 Spec. includes CAN 2.0A and CAN 2.0B. CAN 2.0A supports standard 11 bit Identifier. CAN 2.0B supports both 11 bit Identifier and extended 29 bit Identifier. So CAN 2.0B are compatible with CAN 2.0A. SJA1000 supports BasicCAN mode and PeliCAN mode. BasicCAN mode supports CAN 2.0A, while PeliCAN mode supports 2.0B. Advantech CAN Windows WDM&CE Driver runs in PeliCAN mode, thus it can support both Standard frame and Extended frame.

While sending and receiving messages, the user can set or tell the message type via canmsg_t.flags. For detailed information, please refer to canmsg_t.

The following part introduces how to send and receive CAN messages.

4.5.1 How to send Standard frame, compatible with CAN 2.0A.

```c
DWORD dwWrite = 0;
canmsg_t WriteBuffer;
ZeroMemory(&WriteBuffer, sizeof(canmsg_t));
WriteBuffer.flags = 0; //Standard frame
WriteBuffer.id = 0;
WriteBuffer.length = 8;
for(int i=0; i<8; i++)
{
    WriteBuffer.data[i] = i;
}
WriteFile(hDevice, &WriteBuffer, 1, &dwWrite, 0);
```
4.5.2 How to send Extended frame, compatible with CAN 2.0B.

```c
DWORD    dwWrite=0;
canmsg_t WriteBuffer;
ZeroMemory(&WriteBuffer, sizeof(canmsg_t));
WriteBuffer.flags = MSG_EXT; //Extended frame
WriteBuffer.id = 0;
WriteBuffer.length = 8;
for(int i=0; i<8; i++)
{
    WriteBuffer.data[i] = i;
}
WriteFile(hDevice, &WriteBuffer, 1, &dwWrite, 0);
```

4.5.3 How to send RTR frame.

```c
DWORD    dwWrite=0;
canmsg_t WriteBuffer;
ZeroMemory(&WriteBuffer, sizeof(canmsg_t));
WriteBuffer.flags = 0; //Standard frame
//WriteBuffer.flags = MSG_EXT; //Extended frame
WriteBuffer.flags |= MSG_RTR; //Remote frame
WriteBuffer.id = 0;
WriteBuffer.length = 0;
WriteFile(hDevice, &WriteBuffer, 1, &dwWrite, 0);
```

4.5.4 How to dispose received messages.

```c
DWORD dwRead;
canmsg_t ReadBuffer;
ZeroMemory(&ReadBuffer, sizeof(canmsg_t));
BOOL bSuccess = ReadFile(hDevice, &ReadBuffer, 1, &dwRead, 0);
if(bSuccess)
{
    if(dwRead == 1)
    {
        //SUCCESS
        if(ReadBuffer.flags & MSG_EXT)
        {
            //Extended frame
        } else{
            //Standard frame
        }
        if(ReadBuffer.flags & MSG_RTR)
        {
            //Remote frame
        } else{
            //Self frame
        }
    }
}
```
//self reception
}
if(ReadBuffer.flags & MSG_BOVR)
{
    //receive buffer overflow
}
if(ReadBuffer.flags & MSG_BUSOFF)
{
    //CAN controller bus off
}
if(ReadBuffer.flags & MSG_OVR)
{
    //CAN controller Msg overflow error
}
if(ReadBuffer.flags & MSG_PASSIVE)
{
    //CAN controller in error passive
}
}
else{
    //Timeout
}
}
else{
    DWORD dwError = GetLastError();

    if (dwError == ERROR_IO_PENDING)
    {
        //pended
    }
    else if(dwError == ERROR_INVALID_PARAMETER)
    {
        //parameter error
    }
    else if(dwError == ERROR_OPERATION_ABORTED)
    {
        //cancelled
    }
    else if(dwError == ERROR_GEN_FAILURE)
    {
        //bus off
    }
}

See Also
    canmsg_t
    WriteFile
    ReadFile
4.6 Acceptance filtering

Acceptance code corresponds to 4 registers: ACR0, ACR1, ACR2, ACR3. Acceptance mask corresponds to 4 registers: AMR0, AMR1, AMR2, AMR3. ACR works with AMR. Only when the acceptance filtering of the Standard frame or the Extended frame is confirmed, will the filter save the data of the frame into FIFO.

For AMR bits,
- 0: the corresponding bits of ACR and CAN information frames should be the same in order to be accepted.
- 1: the acceptance filtering function of the corresponding ACR bits is disabled and the corresponding bits of the CAN information frame are independent of the acceptance result.

Single mode

For Standard frame, 11 identifiers and the RTR bit correspond to ACR0, ACR1, AMR0 and AMR1 with unused lower 4 bits of ACR1 and AMR1. Since the Standard frame has 11 identifiers only, the first 2 bytes of the data field are also included for filtering. Data1 corresponds to ACR2, AMR2; Data2 corresponds to ACR3, AMR3. If the received Standard frame is a Remote frame and the RTR bit is 1, then only the identifier will be used for filtering. If the received Standard frame is a data frame and the data field is less than 2 bytes, then the missed data will not be used for filtering. For Extended frame, 29 identifiers and the RTR bit correspond to 4 ACRs and 4 AMRs. Please note that the lower 2 bits of ACR3 and AMR3 are reserved.

Example of Standard frame:

<table>
<thead>
<tr>
<th>0</th>
<th>1 (lower 4 bits)</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR</td>
<td>11XXX010</td>
<td>XXXX</td>
<td>XXXXXXXX</td>
</tr>
<tr>
<td>ACM</td>
<td>00111000</td>
<td>1111</td>
<td>11111111</td>
</tr>
<tr>
<td>accepted ID(ID.10~ID.0)</td>
<td>11XXX010</td>
<td>XXX</td>
<td></td>
</tr>
</tbody>
</table>

In this example, Data1, Data2 and RTR are not considered and the accepted IDs include: 0x7D7(11111010111), 0x610(11000010000), etc.

Example of Extended frame:

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR</td>
<td>10010100</td>
<td>1011000X</td>
<td>1100XXXX</td>
</tr>
<tr>
<td>ACM</td>
<td>00000000</td>
<td>00000001</td>
<td>00001111</td>
</tr>
<tr>
<td>accepted ID(ID.28~ID.0)</td>
<td>10010100</td>
<td>1011000X</td>
<td>1100XXXX</td>
</tr>
</tbody>
</table>

In this example, RTR is not considered and the accepted IDs include: 0x12961806(100101001011000110000000000110), 0x129639E6(100101001011000111001110011001110), etc.
Dual Mode

Dual filtering is more complicated than single filtering. In Dual filtering mode, 4 ACRs and 4 AMRs form two filters; the received information frame could be accepted by either filter. For Standard frame, filter1 is composed of ACR0, ACR1, AMR0, AMR1 and the lower four bits of ACR3 and AMR3. It corresponds to 20 bits, including 11 identifiers, the RTR bit and the first byte; all of 20 bits are used for the filtering. Filter2 is composed of ACR2, AMR2 and the higher four bits of ACR3 and AMR3, while only 11 identifiers and the RTR bit are used for the filtering. For Extended frame, filter1 is composed of ACR0, ACR1, AMR0 and AMR1, not including ACR3 and AMR3. What’s more, there are only 16 bits out of 29 bits used for the filtering. Filter2 is composed of ACR2, ACR3, AMR2 and AMR3. The higher 16 bits out of 29 bits are used for the filtering.

Example of Standard frame:

Filter1:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>3 (lower 4 bits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR</td>
<td>00000000</td>
<td>001XXXXX</td>
</tr>
<tr>
<td>ACM</td>
<td>00000000</td>
<td>00011111</td>
</tr>
<tr>
<td>accepted ID(ID.10``ID.0)</td>
<td>00000000</td>
<td>001</td>
</tr>
</tbody>
</table>

In this example, Data1 and RTR are not considered and the accepted ID: 0x1.

Filter2:

<table>
<thead>
<tr>
<th></th>
<th>2</th>
<th>3 (upper 4 bits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR0-ACR3</td>
<td>00000000</td>
<td>001X</td>
</tr>
<tr>
<td>ACM0-ACM3</td>
<td>00000000</td>
<td>0001</td>
</tr>
<tr>
<td>accepted ID(ID.10``ID.0)</td>
<td>00000000</td>
<td>001</td>
</tr>
</tbody>
</table>

In this example, RTR are not considered and the accepted ID: 0x1.

Example of Extended frame:

Filter1:

<table>
<thead>
<tr>
<th></th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR</td>
<td>00000000</td>
</tr>
<tr>
<td>ACM</td>
<td>00000000</td>
</tr>
<tr>
<td>accepted ID(ID.28``ID.13)</td>
<td>00000000</td>
</tr>
</tbody>
</table>

In this example, the accepted IDs include: 0x2000(100000000000000), 0x3FFF(11111111111111), etc.

Filter2:

<table>
<thead>
<tr>
<th></th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACR</td>
<td>00000000</td>
</tr>
<tr>
<td>ACM</td>
<td>00000000</td>
</tr>
<tr>
<td>accepted ID(ID.28``ID.13)</td>
<td>00000000</td>
</tr>
</tbody>
</table>

In this example, the accepted IDs include: 0x2000(100000000000000), 0x3FFF(11111111111111), etc.
4.7 Advantech CAN Windows WDM&CE Driver application development guide

Users can directly access drivers with WINDOWS Native API. In the following, we will provide an example by opening a CAN port and reading its current status to explain how to write basic applications in VC, VB, VB.NET and C# environment. Necessary files for developing applications are listed below. Suppose installation paths of all header files in the example are C:\Program Files\ADVANTECH\AdvCAN\Include.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdvCan.h</td>
<td>Header file for VC</td>
</tr>
<tr>
<td>AdvCan.cs</td>
<td>Header file for C#</td>
</tr>
<tr>
<td>AdvCan.vb</td>
<td>Header file for VB.NET</td>
</tr>
<tr>
<td>AdvCan.bas</td>
<td>Header file for VB</td>
</tr>
</tbody>
</table>

**Note!** Users who use CAN driver on windows CE can directly refer to Structure list and Introduction to API (GetOverlappedResult is not included).

4.7.1 Guide for Visual C++ development

We will give an example by opening a CAN port and reading its current status so as to simply explain how to write base applications in Visual C++ environment.

4.7.1.1 Create a new VC project

Related header files must be used before using Advantech CAN Windows WDM&CE Driver interface function. Make sure the driver had been installed correctly. (Please refer to relevant books and documentations regarding detailed information about VC development.)

Please follow the following procedures to create a new VC++ project:

1. Select "File/New" from the main menu to create a new application project and source file. Define the type of the new project as "Win32 Console Application", define the platform as "Win32" and select a path for files of the project.

![Image of Visual Studio project creation]

2. Click "OK"->"Finish"->"OK" according to the instructions on the screen.

A new VC project is created.

![Image of Visual Studio project creation result]
4.7.1.2 Add necessary files

1. Add Include header files (AdvCan.h) in Advantech CAN Windows WDM&CE Driver. In VC++ work area, right click "Header Files", then select "Add Files to Folder" to add header files to the project.

4.7.1.3 Write code

1. “Select "Add to Project->New" from "Project"£¨ then select "C++ Source File".
Write code in empty source file.

```c
#include <stdio.h>
#include <windows.h>
#include "C:\Program Files\Advantech\AdvCan\Include\AdvCan.h"

void main()
{
    HANDLE hDevice = NULL;
    CanStatusPar_t CanStatus;
    BOOL flag;
    ULONG dwReturned;
    //Open Can Port "CAN1".
    //You can also change "CAN1" to a port name which you have installed.
    hDevice = CreateFile("\\.\\can1",
    GENERIC_READ | GENERIC_WRITE,
    0,
    NULL,OPEN_EXISTING,
    0,
    NULL);
    if ( hDevice == INVALID_HANDLE_VALUE )
    {
        printf( "Open Can Port Error!" );
        return;
    }
    // Get Can port status.
    flag = DeviceIoControl( hDevice,
    CAN_IOCTL_STATUS,
    NULL,
    0,
    &CanStatus,
    sizeof(CanStatusPar_t),
    &dwReturned,
    0 );
    if ( !flag )
    {
        printf( "GetStatus Error!" );
        return;
    }
    printf( "Acceptance code = 0x%x\n" , CanStatus.acceptancecode );
    printf( "Acceptance mask = 0x%x\n" , CanStatus.acceptancemask );
    printf( "Baud = %u\n" , CanStatus.baud );
    printf( "Self reception = %u\n" , CanStatus.selfreception );
    printf( "Read time out = %u\n" , CanStatus.readtimeout );
    printf( "Write time out = %u\n" , CanStatus.writetimeout );
    //Close port handle
    flag =CloseHandle(hDevice);
    if ( !flag )
    {
        printf( "Close Error!" );
        return;
    }
}
```
4.7.1.4 Test application
Run the application, the following result will be displayed.

4.7.2 Guide for Visual Basic development
We will give an example by opening a CAN port and reading its current status so as to simply explain how to write base applications in Visual Basic environment.

4.7.2.1 Create a new VB project
Related header files must be used before using Advantech CAN Windows WDM&CE Driver interface function. Make sure the driver had been installed correctly.
(Please refer to relevant books and documentations regarding detailed information about VB development.)
Please follow the following procedures to create a new VB project:
1. Select "File"->"New Project" from the main menu. For Project Types, select Standard EXE.

A new VB project is created.
4.7.2.2 Add files and design graphical interfaces

1. Add Include header files (AdvCan.bas) in AdvCAN Windows WDM&CE Driver. Right click the project and select Add->Module Item, then select Existing Item to add AdvCan.bas. (Installation path\AdvCan\Include\AdvCan.bas)
2. Design graphical interfaces. Add one Button and six Text controls to Form1.

![Form1 with Button1, Baud rate, Accept code, Mask code, Self receive, Read TimeOut, Write TimeOut]

### 4.7.2.3 Write code

1. Write corresponding code for Button1.

```vba
Private Sub Button1_Click()
    Dim hDevice As Long
    Dim Status As CanStatusPar_t
    Dim result As Boolean
    Dim dwOutLen As Long
    Dim ov As OVERLAPPED

    'Open Can Port "CAN1".
    'You can also change "CAN1" to a port's name which you have installed.
    hDevice = CreateFile("\\\can1", GENERIC_READ + GENERIC_WRITE, 0&, 0&, OPEN_EXISTING, FILE_ATTRIBUTE_NORMAL + FILE_FLAG_OVERLAPPED, 0&) 'Open the CAN port in synchronous mode
    If hDevice = &HFFFFFFFF Then
        MsgBox ("Open Error!")
        Exit Sub
    End If

    'Get Can port status.
    result = DeviceIoControl(hDevice, CAN_IOCTL_STATUS, Nothing, 0&, Status, Len(Status), dwOutLen, 0&) 'Open the CAN port in synchronous mode
    If Not result Then
        MsgBox ("GetStatus Error!")
        Exit Sub
    End If
```

2. Design graphical interfaces. Add one Button and six Text controls to Form1.

![Form1 with Button1, Baud rate, Accept code, Mask code, Self receive, Read TimeOut, Write TimeOut]

### 4.7.2.3 Write code

1. Write corresponding code for Button1.

```vba
Private Sub Button1_Click()
    Dim hDevice As Long
    Dim Status As CanStatusPar_t
    Dim result As Boolean
    Dim dwOutLen As Long
    Dim ov As OVERLAPPED

    'Open Can Port "CAN1".
    'You can also change "CAN1" to a port's name which you have installed.
    hDevice = CreateFile("\\\can1", GENERIC_READ + GENERIC_WRITE, 0&, 0&, OPEN_EXISTING, FILE_ATTRIBUTE_NORMAL + FILE_FLAG_OVERLAPPED, 0&) 'Open the CAN port in synchronous mode
    If hDevice = &HFFFFFFFF Then
        MsgBox ("Open Error!")
        Exit Sub
    End If

    'Get Can port status.
    result = DeviceIoControl(hDevice, CAN_IOCTL_STATUS, Nothing, 0&, Status, Len(Status), dwOutLen, 0&) 'Open the CAN port in synchronous mode
    If Not result Then
        MsgBox ("GetStatus Error!")
        Exit Sub
    End If
```
End If
TextBox1.Text = "Baud rate= " + CStr(Status.baud)
TextBox2.Text = "Accept code = " + Hex(Status.acceptance-code)
TextBox3.Text = "Mask code = " + Hex(Status.acceptance-mask)
TextBox4.Text = "Self recevie = " + CStr(Status.selfrecep tion)
TextBox5.Text = "Read TimeOut = " + CStr(Status.ReadTime-Out)
TextBox6.Text = "Write TimeOut: = " + CStr(Status.WriteTimeOut)
result = CloseHandle(hDevice) 'Close the CAN port
If Not result Then
    MsgBox ("Failed to close the CAN port!")
End If
End Sub

4.7.2.4 Test application
Run the application, the following result will be displayed.
4.7.3 **Guide for VC.NET development**

We will give an example by opening a CAN port and reading its current status so as to simply explain how to write base applications in VC.NET environment.

4.7.3.1 **Create a new VC.NET project**

Related header files must be used before using Advantech CAN Windows WDM&CE Driver interface function. Make sure the driver had been installed correctly. (Please refer to relevant books and documentations regarding detailed information about VC.NET development.)

Please follow the following procedures to create a new VC.NET project:

1. Select "File/New->Project" from the main menu to create a new application project and source file. Define the type of the new project as "Windows Forms Application", and select a path for files of the project.

   ![Creating a new VC.NET project](image1.png)

2. Click "OK" according to the instructions on the screen.

A new VC.NET project is created.

4.7.3.2 **Add necessary files**

1. Add Include header files (AdvCan.h) in Advantech CAN Windows WDM&CE Driver. In VC.NET work area, right click "Header Files" and select "Add -> Existing Item" to add header files to the project in the "Add Existing Item - Test" file list.

   ![Adding header files](image2.png)
2. Design graphical interfaces. Add one Button and six Text controls to Form1.
### 4.7.3.3 Write code

Write code in source file.

```csharp
#include <windows.h>
#include "../../../Include/AdvCan.h"

private: System::Void button1_Click(System::Object^ sender, System::EventArgs^ e)
{
    HANDLE hDevice = 0;
    BOOL result;
    int dwOutLen=0;
    int lpSecurityAttributes=0;
    OVERLAPPED ov ;
    CanStatusPar_t CanStatus;
    Command_par_t cmd;
    //Open Can Port "CAN1".
    //You can also change "CAN1" to a port's name which you have installed.
    System::String^ CanPortName = "\\.\" + "can1";
    TCHAR* LWCanPortName= static_cast<TCHAR*>(System::Runtime::InteropServices::Marshal::StringToCoTaskMemAuto( CanPortName).ToPointer());
    hDevice = CreateFile( LWCanPortName,GENERIC_READ | GENERIC_WRITE,0,(LPSECURITY_ATTRIBUTES)lpSecurityAttributes,OPEN_EXISTING,
    FILE_ATTRIBUTE_NORMAL|FILE_FLAG_OVERLAPPED,NULL);
    if( (unsigned int)hDevice == 0xffffffff )
    {
        MessageBox::Show("Open CAN port Error!");
        return;
    }
    //Get Can port status.
    result = DeviceIoControl( hDevice,(ULONG)CAN_IOCTL_STATUS,&cmd,0,&CanStatus,sizeof(CanStatusPar_t),(LPDWORD)&dwOutLen,&ov);
    if( !result )
    {
        MessageBox::Show("GetStauts Error!");
        return;
    }
    this->textBox1->Text = "Baud rate = " + CanStatus.baud.ToString();
    this->textBox2->Text = "Accept code = " + CanStatus.acceptancecode.ToString("X2");
    this->textBox3->Text = "Mask code = " + CanStatus.acceptance_mask.ToString("X2");
    this->textBox4->Text = "Self recevie = " + CanStatus.selfreception.ToString();
    this->textBox5->Text = "Read TimeOut = " + CanStatus.readtimeout.ToString();
    this->textBox6->Text = "Write TimeOut= " + CanStatus.writetimeout.ToString();
    result = CloseHandle( hDevice ); //Close the CAN port
    if ( ! result )
    {
        MessageBox::Show ("GetStauts Error!");
        return;
    }
}
```
4.7.3.4 **Test application**

Run the application, the following result will be displayed.

![Form1](image)

Baud rate = 125

Accept code = FFFFFFFF

Mask code = FFFFFFFF

Self receive = 0

Read TimeOut = 3000

Write TimeOut = 5000

4.7.4 **Guide for VB.NET development**

We will give an example by opening a CAN port and reading its current status so as to simply explain how to write base applications in VB.NET environment.

4.7.4.1 **Create a new VB.NET project**

Related header files must be used before using Advantech CAN Windows WDM&CE Driver interface function. Make sure the driver had been installed correctly.

(Please refer to relevant books and documentations regarding detailed information about VB.NET development.)
Please follow the following procedures to create a new VB.NET project:

1. Select "File"->"New"->"Project" from the main menu. For Project Types, select Visual Basic Projects. Templates is Windows Application.

A new VB.NET project is created.

4.7.4.2 Add files and design graphical interfaces

1. Add Include header files (AdvCan.vb) in AdvCAN Windows WDM&CE Driver. Right click the project, then select Add->Add Existing Item to add AdvCan.vb. (Installation path\AdvCan\Include\AdvCan.vb)
2. Design graphical interfaces. Add one Button and six Text controls to Form1.

4.7.4.3 Write code
1. Write corresponding code for Button1.

```vbnet
Private Sub Button1_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Button1.Click
    Dim hDevice As IntPtr
    Dim status As CanStatusPar_t
    Dim result As Boolean
    Dim dwOutLen As Integer
    Dim ov As New OVERLAPPED

    'Open Can Port "CAN1".
    'You can also change "CAN1" to a port's name which you have installed.
    hDevice = CreateFile("\\.\can1", GENERIC_READ + GENERIC_WRITE, 0, Nothing, OPEN_EXISTING, FILE_ATTRIBUTE_NORMAL + FILE_FLAG_OVERLAPPED, 0)
    If hDevice.ToInt32 = &HFFFFFFFF Then
        MsgBox("Open Error!")
        Exit Sub
    End If

    'Get Can port status.
    result = DeviceIoControl(hDevice, CAN_IOCTL_STATUS, Nothing, 0, status, Len(status), dwOutLen, ov)
    If Not result Then
        MsgBox("GetStatus Error!")
        Exit Sub
    End If

    TextBox1.Text = "Baud rate= " & status.baud
```
TextBox2.Text = "Accept code = " & Hex(status.acceptance-code)
TextBox3.Text = "Mask code = " & Hex(status.acceptance-mask)
TextBox4.Text = "Self recevie = " & status.selfreception
TextBox5.Text = "Read TimeOut = " & status.readtimeout
TextBox6.Text = "Write TimeOut: = " & status.writetimeout
result = CloseHandle(hDevice) 'Close the CAN port
If Not result Then
    MsgBox("Failed to close the CAN port!")
End If
End Sub

4.7.4.4 Test application
Run the application, the following result will be displayed.

![Form1](image)
4.7.5 **Guide for C# development**

We will give an example by opening a CAN port and reading its current status so as to simply explain how to write base applications in C# environment.

4.7.5.1 **Create a new C# project**

Related header files must be used before using Advantech CAN Windows WDM&CE Driver interface function. Make sure the driver had been installed correctly. (Please refer to relevant books and documentations regarding detailed information about C# development.)

Please follow the following procedures to create a new C# project:

1. Select "File"->"New"->"Project" from the main menu. For Project Types, select Visual C# Projects. Templates is Windows Application.

2. Type the name and saving path of the project according to instructions on the screen, and click "OK".

A new C# project is created.

![New Project Dialog](image)
4.7.5.2 Add files and design graphical interfaces

   Right click the project, then select Add->Add Existing Item to add AdvCan.cs.
   (Installation path\AdvCan\Include\AdvCan.cs)
2. Design graphical interfaces. Add one Button and six TextBox controls to Form1.
4.7.5.3 Write code

1. Add the following code to Button:

   ```csharp
   private void button1_Click(object sender, System.EventArgs e)
   {
       uint hDevice = 0;
       bool result;
       int dwOutLen = 0;
       int lpSecurityAttributes = 0;
       AdvCan.OVERLAPPED ov = new AdvCan.OVERLAPPED();

       //Open Can Port "CAN1".
       //You can also change "CAN1" to a port's name which you have
       //installed.
       hDevice = AdvCan.CreateFile("\\.\can1", AdvCan.GENERIC_READ +
       AdvCan.GENERIC_WRITE, 0, lpSecurityAttributes, Adv-
       Can.OPEN_EXISTING, AdvCan.FILE_ATTRIBUTE_NORMAL + Adv-
       Can.FILE_FLAG_OVERLAPPED, 0);
       if (hDevice == 0xffffffff)
       {
           MessageBox.Show("Open CAN port Error!");
           return;
       }

       //Get Can port status.
       result = AdvCan.DeviceIoControl(hDevice, Adv-
       Can.CAN_IOCTL_STATUS, ref cmd, 0, ref CanStatus, Marshal.SizeOf(Can-
       Status), ref dwOutLen, ref ov);
       if (!result)
       {
           MessageBox.Show("GetStauts Error!");
           return;
       }

       textBox1.Text = "Baud rate = " + CanStatus.baud .ToString();
       textBox2.Text = "Accept code = " + CanStatus.acceptancecode
       .ToString("X2");
       textBox3.Text = "Mask code = " + CanStatus.acceptancemask
       .ToString("X2");
       textBox4.Text = "Self recevie = " + CanStatus.selfreception
       .ToString();
       textBox5.Text = "Read TimeOut = " + CanStatus.readtimeout
       .ToString();
       textBox6.Text = "Write TimeOut= " + CanStatus.writetimeout
       .ToString();
       result = AdvCan.CloseHandle(hDevice); //Close the CAN port
       if (!result)
       {
           MessageBox.Show("GetStauts Error!");
           return;
       }
   }
   ```
4.7.5.4 Test application
Run the application, the following result will be displayed.

4.8 Examples
Advantech CAN Windows WDM&CE Driver package contains examples of VC, VB, VB.NET, C#.NET, VC.NET, eVC. Users can refer to these examples to develop applications.

**WDM:**

<table>
<thead>
<tr>
<th>Example Name</th>
<th>Description</th>
<th>VC</th>
<th>VB</th>
<th>VB.NET</th>
<th>C#.NET</th>
<th>VC.NET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Configure</td>
<td>This example shows how to configure each item of CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Send</td>
<td>This example shows how to send data to CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Receive</td>
<td>This example shows how to receive data from CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Event</td>
<td>This example shows how to receive/send data from/to CAN port through events in the way similar to serial port communication.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### 4.8.1 Interface

#### 4.8.1.1 Send

Data is sent. Values of Baud Rate and timeout of the port can be set. Meanwhile, self reception function will be realized.

Please refer to Send flow chart for function calling.

Before you begin, please enter the name of the port you have installed in combobox of CAN Port, such as can0, can1, etc. The user can choose either Standard or Custom to set Baud Rate. If Standard is chosen, you should select the Baud Rate needs to be set from the dropdown list of Baud Rate. If the user chooses Custom, you should write values of BTR0 and BTR1 manually in the textbox. The default values of both are 125k. Type value of timeout in Timeout filed (The default value is 3000 ms). Selecting RTR check box can realize RTR function. Selecting Self Reception check box can realize self reception function. On WDM platform, the user can select either synchronous mode or asynchronous mode. While on CE platform, only synchronous mode is supported. After configuring the above items, users can click "Start" button to send data.

After clicking "Start" button, the name of the button will change into "Stop". At the same time, results of sent frames will be shown in the textbox on the right. Users can click "Stop" button to stop sending frames during the process, then the name of the button will return to "Start" for the next send operation.

<table>
<thead>
<tr>
<th>Example Name</th>
<th>Description</th>
<th>VB.NET</th>
<th>C#.NET</th>
<th>VC.NET</th>
<th>eVC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Configure</td>
<td>This example shows how to configure each item of CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Send</td>
<td>This example shows how to send data to CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Receive</td>
<td>This example shows how to receive data from CAN port.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can Event</td>
<td>This example shows how to receive/send data from/to CAN port through events in the way similar to serial port communication.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
WDM

CE
4.8.1.2 Receive

Data is received. Values of Baud Rate and timeout of the port can be set. Please refer to Receive flow chart for function calling.

Before you begin, please enter the name of the port you have installed in combobox of CAN Port, such as can0, can1, etc. The user can choose either Standard or Custom to set Baud Rate. If Standard is chosen, you should select the Baud Rate needs to be set from the dropdown list of Baud Rate. If the user chooses Custom, you should write values of BTR0 and BTR1 manually in the textbox. The default values of both are 125k. Type value of timeout in Timeout filed (The default value is 3000 ms). On WDM platform, the user can select either synchronous mode or asynchronous mode. While on CE platform, only synchronous mode is supported. After configuring the above items, users can click "Start" button to receive data.

After clicking "Start" button, the name of the button will change into "Stop". At the same time, results of received frames will be shown in the textbox on the right. Users can click "Stop" button to stop receiving frames during the process, then the name of the button will return to "Start" for the next receive operation.

WDM

![WDM CAN Receive]

CE

![CE CAN Receive]
4.8.1.3 Configure

Users can set values of Baud Rate, Timeout of sending and receiving data, mask of receive register and filter. Meanwhile, status of the port can be displayed.

Please refer to Configure flow chart for function calling.

Before you begin, please select the name of the port you have installed in combobox of CAN Port, such as can0, can1, etc. Select value of Baud Rate that you want in dropdown list of Baud Rate (The default value is 125 k). Select Single or Dual of Acceptance Filter Mode. Enter filter mask for receiving data in the fields of Acceptance Mask and Acceptance Code (The default value is 0xFFFFFFFF). Type values of timeout in Write Timeout and Read Timeout fields (The default value is 3000 ms). After configuring the above items, users can click "Configure" button to change the current setting of the port.

After clicking "Configure" button, successful message and the new configuration information will be displayed if you succeed in configuring. In addition, number of received data and values of controllers will be displayed as well. If the configuration fail, prompting message will be displayed.

**Note!** This is only used to change configuration of the application which is currently running. Once "Configure" item is closed, all changes made in it will not be retained.

- WDM
### 4.8.1.4 Event

This function is similar to serial port communication, which send/receive data through events. Baud Rate and timeout values in the example are fixed. The application realizes duplex communication.

Please refer to Event flow chart for function calling.

Before you begin, please select the name of the port you have installed in combobox of CAN Port, such as can0, can1, etc. Value of Baud Rate is fixed at 125 k, and Value of timeout is fixed at 3000 ms. The user can select RTR check box can realize RTR function. After configuring the above items, users can click "Start" button to send/receive data.

After clicking "Start" button, the name of the button will change into "Stop". At the same time, results of sent/received results will be shown in both textboxes. The two ports are using duplex communication. Users can click "Stop" button to stop sending/receiving frames during the process, then the name of the button will return to "Start" for the next send/receive operation.

### WDM
4.8.2 Flow Chart

4.8.2.1 Send flow chart
4.8.2.2 Receive flow chart
4.8.2.3 Configure flow chart

- CreateFile
- Enter Reset Mode
- Set Baud Rate
- Set Acceptance Filter Mode
- Set Acceptance Mask and Acceptance Code
- Set TimeOut
- Enter Work Mode
- Set TimeOut
- Get CAN port status
- CloseHandle
4.8.2.4 Event flow chart
Either flow chart of the two sub threads is as below:
4.9 Use Utility to test hardware

An Utility is provided for users to test whether hardware is working normally. It's installed under C:\Program Files\Advantech\AdvCAN\Utility directory by default. This Utility can be divided into four parts:

In Part 1, users can select which port to open in the choice box at top. Set "Baud Rate", "acceptance filter mode", "acceptance code", "acceptance Mask", and choose if you want to receive "Self Reception" or send "RTR". Users can select "Listen Only" if you want use listen only mode. can also set "Cycle" of data transfer by entering the interval time (ms). Users can select "Auto Increase" if you want the data increase automatically. When setting is finished, users can choose to Open/Close the port, Start Tx/Stop Tx and Start Rx/Stop Rx.

In Part 2, detail information of received data will be shown when communication is built.

In Part 3, the following items will be shown: Numbers of sent frames, timeout sent frames, received frames and timeout received frames. Times of entering PASSIVE error mode, times of entering BUS OFF mode, times of hardware OVERRUN and times of software OVERRUN (BOVERRUN). Users can select ASCII mode. As a result, ASCII format of the data will be shown in Part 2.

In Part 4, ID, Flag (SFF: Standard Frame; EFF: Extended Frame), length and data of messages will be configured before being sent.

System Requirements
4.10 CANMonitor

CANMonitor can be used to monitor the messages in CAN network and to show the messages according to different message types. CANMonitor can show messages in the formats of CAN and CANopen.

**System Requirements**

4.10.1 Function Introduction

This section introduces the functions that CANMonitor supports.

**Base function:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Device</td>
<td>Opens a device and make basic configuration.</td>
</tr>
<tr>
<td>Close Device</td>
<td>Closes a device and clear all the data.</td>
</tr>
<tr>
<td>Load from file</td>
<td>Loads data from the file.</td>
</tr>
<tr>
<td>Save to file</td>
<td>Saves data to the specified file.</td>
</tr>
<tr>
<td>Start Communication</td>
<td>Restarts communication based on the configuration.</td>
</tr>
<tr>
<td>Stop Communication</td>
<td>Stops communication, which is used to view data when the refresh is frequent.</td>
</tr>
<tr>
<td>Show Message</td>
<td>Shows messages.</td>
</tr>
<tr>
<td>Hide Message</td>
<td>Hides messages.</td>
</tr>
<tr>
<td>Clear Data</td>
<td>Clears all data.</td>
</tr>
<tr>
<td>Auto Scroll</td>
<td>Supports auto scroll function.</td>
</tr>
<tr>
<td>Goto</td>
<td>Goes to the specified message line.</td>
</tr>
<tr>
<td>Listen only mode</td>
<td>Supports Listen Only mode.</td>
</tr>
<tr>
<td>CAN Message Filter</td>
<td>Configures CAN message filter modes.</td>
</tr>
<tr>
<td>CAN Message View</td>
<td>Shows CAN format message.</td>
</tr>
</tbody>
</table>

**CANopen function:**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Node</td>
<td>Lists CANopen nodes detected and the node state.</td>
</tr>
<tr>
<td>Change Node State</td>
<td>Changes the specified CANopen node state.</td>
</tr>
<tr>
<td>Read Data from Node</td>
<td>Reads data from the specified CANopen node.</td>
</tr>
<tr>
<td>Write Data to Node</td>
<td>Writes data to the specified CANopen node.</td>
</tr>
<tr>
<td>Detect All Nodes in CANopen</td>
<td>Detects all the possible CANopen nodes, from 1 to 127.</td>
</tr>
<tr>
<td>CAN Message Filter</td>
<td>Configures CAN message filter modes.</td>
</tr>
<tr>
<td>CANopen Message Filter</td>
<td>Configures CANopen message filter modes.</td>
</tr>
<tr>
<td>CAN Message View</td>
<td>Shows CAN format message.</td>
</tr>
<tr>
<td>CANopen Message View</td>
<td>Shows CANopen format message.</td>
</tr>
</tbody>
</table>
4.10.2 Introduction to Main Items in Menu Screen

Menu Introduction

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>Open device</td>
</tr>
<tr>
<td>Close</td>
<td>Close device</td>
</tr>
<tr>
<td>Load</td>
<td>Load data from File</td>
</tr>
<tr>
<td>Save</td>
<td>Save data to File</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the program</td>
</tr>
</tbody>
</table>

View

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Whether to show the toolbar</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Whether to show the status bar</td>
</tr>
<tr>
<td>Auto Scroll</td>
<td>Whether to scroll automatically</td>
</tr>
<tr>
<td>Clear</td>
<td>Clear all the messages</td>
</tr>
<tr>
<td>Goto</td>
<td>Go to the specified line</td>
</tr>
</tbody>
</table>
**Data Format**

Data Format has following setting:

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hex</td>
<td>The monitor data which includes &quot;ID&quot; and &quot;Data&quot; will be displayed as Hex format.</td>
</tr>
<tr>
<td>Dec</td>
<td>The monitor data which includes &quot;ID&quot; and &quot;Data&quot; will be displayed as Dec format.</td>
</tr>
<tr>
<td>Ascii</td>
<td>The monitor &quot;Data&quot; will be displayed as Dec format but &quot;ID&quot; will be displayed as Hex format</td>
</tr>
</tbody>
</table>

**Function**

Function has the following functions:

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Start communication</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop communication</td>
</tr>
<tr>
<td>Show</td>
<td>Show the message</td>
</tr>
<tr>
<td>Hide</td>
<td>Hide the message</td>
</tr>
<tr>
<td>Listen</td>
<td>Only Whether to open Listen Only mode</td>
</tr>
</tbody>
</table>

**CAN**

CAN has a submenu:

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send CAN Message</td>
<td>Send CAN Message</td>
</tr>
</tbody>
</table>
**CANopen**

CANopen has the following functions:

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Node</td>
<td>List all CANopen nodes</td>
</tr>
<tr>
<td>Change Node</td>
<td>State Change CANopen node state</td>
</tr>
<tr>
<td>Read Object</td>
<td>Read CANopen node data</td>
</tr>
<tr>
<td>Write Object</td>
<td>Write CANopen node data</td>
</tr>
<tr>
<td>Node Guard All</td>
<td>Get all CANopen nodes</td>
</tr>
</tbody>
</table>

**Filter**

Filter has CAN Filter setting

and CANopen Filter setting.
Toolbar Introduction

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Open device</td>
</tr>
<tr>
<td>Close</td>
<td>Close Device</td>
</tr>
<tr>
<td>Load</td>
<td>Load data from file</td>
</tr>
<tr>
<td>Save</td>
<td>Save data to file</td>
</tr>
<tr>
<td>Run</td>
<td>Start communication</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop communication</td>
</tr>
<tr>
<td>Show</td>
<td>Show the message</td>
</tr>
<tr>
<td>Hide</td>
<td>Hide the message</td>
</tr>
<tr>
<td>Auto</td>
<td>Scroll Whether to scroll automatically</td>
</tr>
<tr>
<td>Clear</td>
<td>Clear all the messages</td>
</tr>
</tbody>
</table>

Status Bar Introduction

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Show the load; the two formats - Kbit/s and bit/s will be selected automatically</td>
</tr>
<tr>
<td>S2</td>
<td>Show the current status of the device: Normal, Passive, Bus off</td>
</tr>
<tr>
<td>S3</td>
<td>Show the number of the messages sent</td>
</tr>
<tr>
<td>S4</td>
<td>Show the number of the messages received</td>
</tr>
<tr>
<td>S5</td>
<td>Show the number of Overrun</td>
</tr>
<tr>
<td>S6</td>
<td>Show the number of lines of the data; the maximum number will not exceed the number configured when the device is open</td>
</tr>
</tbody>
</table>
4.11 COTI.DLL for CANopen Conformance Test

The COTI DLL allows users to use the CANopen Conformance Test Tool of CiA(CAN in Automation) with Advantech CAN WDM Driver. This file has to be copied into the directory of the CANopen Conformance Test. More detailed presentation about CANopen Conformance Test Tool, please refer to: http://www.can-cia.org/index.php?id=141.

The default installation path for COTI.DLL is C:\Program Files\Advantech\Adv-CAN\COTI.

System Requirements
Chapter 5

Pin Assignments and Wiring

This chapter covers the pin assignment for the CAN connector, and the wiring of the two transmission wires.
Sections include:
- Pin Assignments
- Wiring
5.1 Pin Assignments

Figure 5.1 shows the pin assignment for the card's DB-9 connectors:

![Diagram of DB-9 connector pin assignments]

Figure 5.1 PCI-1680U/1682U DB-9 pin assignment

5.2 Wiring

The CAN standard supports half-duplex communication. This means that just two wires are used to transmit and receive data.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>CAN_L</td>
<td>CAN_L</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>7</td>
<td>CAN_H</td>
<td>CAN_H</td>
</tr>
</tbody>
</table>

Table 5.1: PCI-1680U/1682U Pin Wiring and Description